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1 Introduction

11 About This Document

This document describes to how to install and configure the SAP Quotation and Underwriting for Insurance
(FS-QUO) development toolkit to create an FS-QUO development environment.

1.2 Audience

This document is intended for technical consultants and developers who modify FS-QUO functionality. It's
assumed that you have experience developing applications using UI5 and Java.
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2 Prerequisites

2.1 Prerequisites for Installing the FS-QUO Toolkit

This topic details the software that is required before you can install the FS-QUO toolkit.

Before you install the toolkit, download the following software:

Oracle Java Development Kit SE8 for  This is required to run Eclipse.

Windows x86_64 Download the software here # .
Eclipse Oxygen IDE for Java EE Download the software here # .
Developers Windows 64 bit

Apache Maven 3.2.2 Download the software here #* .
Apache TomEE+1.7.5 Download the software here #* .

SAP HANA Client 2.0, revision 003 Use the SAPCAR tool to extract the HANA client SAR file, then extract
ngdbc. jar from SAP_HANA CLIENT/client/JDBC.TGZ.

Download the client here i
You can download the SAPCAR utility here#.

SAP Java Connector (JCo) 2.x and 3.x Download SAP Jco 2.x and 3.x versions by searching for "SAP JCo" in
the Software Download Center#

SAP Cloud Platform Cloud Connector Download the Windows 64-bit x86 software available in the Cloud
Connector area here.

2.2 Understanding the FS-QUO Development Toolkit
Contents

The development environment consists of all the required software and source code to help you extend
FS-QUO functionality.

A Caution

Before you work with the FS-QUO source code, see the Source Code Terms and Conditions [page 6].
The FS-QUO development toolkit is a ZIP file that contains the pre-configured FS-QUO Maven projects. These
projects include the source code.
The following projects are provided in the toolkit:

ASLibrary This project has been deprecated.

Development Toolkit Guide
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http://help.sap.com/disclaimer?site=https%3A%2F%2Flaunchpad.support.sap.com%2F%23%2Fsoftwarecenter%2Fsearch%2FSAPCAR
http://help.sap.com/disclaimer?site=https%3A%2F%2Flaunchpad.support.sap.com%2F%23%2Fsoftwarecenter
https://tools.hana.ondemand.com/#cloud

ASModel

ASTxnModel

ASWebService
com.sap.fs.quo.domain.data

com.sap.fs.quo.cov.service.impl

com.sap.fs.quo.cov.service.internal

com.sap.fs.quo.cov.web

com.sap.fs.quo.cov.service.api

com.sap.fs.quo.service
com.sap.fs.quo.service.api
com.sap.fs.quo.service.impl
com.sap.fs.quo.service.internal
com.sap.fs.quo.web
dependencies

DPPWeb

FS-QUO-dev

FS-QUO-dev-webapp

FS-QUO-install

FS-QUO-mta
FS-QUO-webapp
IntegrationMessageSpec
IPWWeb
MultiLevelRiskRenderer

QUOLibrary

QUOODatalLibrary
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This project has been deprecated.

This project has been deprecated.

This project has been deprecated.

The Domain Data Model for FS-QUO.

Business services for coverage-based products in FS-QUO.
Core services for coverage-based products in FS-QUO.
OData services for coverage-based products in FS-QUO.

Public API for the business services for coverage-based products in FS-
QUO.

Business service interface for risk-based products in FS-QUO.

Public API for the business services for risk-based products in FS-QUO.
Business services for risk-based products in FS-QUO.

Core services for risk-based products in FS-QUO.

OData services for risk-based products in FS-QUO.

Compiled JAR files and 3rd party libraries.

The DDPWeb project contains the Personal Data Search UI5 application,
for use in DPP compliance.

The app allows the search for personal data using a personal identifier,
exporting of personal data as CSV file and the anonymization of personal
data.

A module containing artifacts, such as a local <CSI_HOME>, required to
run FS-QUO in the integrated development environment.

Artifacts for deployment to an application server.

Contains additional artifacts for development and testing.

A module containing the <CSI_HOME> content for FS-QUO and creating
the <CSI_HOME> package for deployment.

Artifacts for deployment to an SAP HANA XS Advanced environment.
Artifacts for deployment to an application server.

This project has been deprecated.

The web container for the FS-IPW back-end.

This project has been deprecated.

The QuoODataWeb project is a dynamic web project, which exposes FS-
QUO back-end functionality and services as OData services.

This project is built as a WAR module and assembled into the FS-

QUO . ear with web context root, 'quo-odata’.

The QuoODataWeb project is a dynamic web project, which exposes FS-
QUO back-end functionality and services as OData services.
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This project is built as a WAR module and assembled into the FS-
QUO.ear with web context root, 'quo-odata’.

UWCMSService This module contains the Content Management System functionality
used by the Underwriter Worklist app.
The default implementation uses SAP Mobile Documents for content
management and Netweaver VSI for virus scanning of file attachments.

UWLibrary This project provides business and data access services specific to FS-
QUO Underwriting. The business services contained within this module
are primarily consumed by the OData processors in UWODataLibrary.

This project builds as a JAR UWModel.

This module provides the central location for UW bean definitions.

UWModel This module provides the central location for Underwriting bean
definitions.
UWODatalLibrary This project contains the Underwriting specific extensions and

implementations of PQMODataL ibrary. The OData processors
defined within this library primarily consume the core FS-QUO

and Underwriting business services contained within ASLibrary and
UWLibrary, respectively.

2.3 Source Code Terms and Conditions

The FS-QUO source code described in this guide is the intellectual property (IP) of SAP SE. The source code is
available for customers to support extension.

Any changes that you make to the core source code voids part of the warranty or the entire warranty.

For more information about IP terms and conditions, see the license agreement.

2.4 Supported Clients

The FS-QUO client is browser-based.

For information about the browsers that are supported, see Client System Requirements.

Development Toolkit Guide
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2.5 Substitution Variable Placeholders

The following table defines the substitution variables used in this guide. Gather the information listed prior to

beginning.

Substitution Variable

Description

<rel> The FS-QUO release version that you are installing.

<sp> The support package version you are installing or upgrading.
<pl> The patch level of you are installing or upgrading.
<CSI_HOME> The installation directory of the file system portion of an

FS-PRO or FS-QUO installation.

<eclipse_dir>

The local directory where the Eclipse application is installed.

<toolkit_dir>

The local directory where the FS-QUO toolkit is installed.

<jdk_dir>

The installation directory of the JDK.

<dev_profile_name>

The name of your FS-QUO development profile.

<quo_toolkit_url>

The URL to the FS-QUO Design Time approuter application
corresponding to your local FS-QUO development setup -
"localhost:8080".

<FS-PM_dest_name>

The destination name for connectivity with FS-PM.

<BP_dest_name>

The destination name for connectivity with SAP GP-FS.

Development Toolkit Guide
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3

This topic describes, at a high-level, the steps involved in installing the FS-QUO toolkit.

Installing the FS-QUO Toolkit

You need to perform the following steps in order to install the FS-QUO toolkit:

3.1

Connecting to the FS-QUO Runtime Database

Installing and Configuring Eclipse

Installing and Configuring TomEE+

Installing and Configuring the FS-QUO Toolkit

Copying and Deploying Insurance Product JAR Files from the Product Modeler
Configuring the FS-QUO Toolkit for FS-QUO

Installing and Configuring Standalone SAP JCo (Optional)

Validating the Complete FS-QUO Toolkit Installation

Connecting to the FS-QUO Runtime Database

Using the steps described in the SAP Quotation and Underwriting for Insurance Installation Guide, the
solution architect in the FS-QUO development team is responsible for setting up the FS-QUO development
infrastructure for the first time in the XSA environment. The FS-QUO database will be shared by the
development team, who must have the necessary access to the XSA environment.

The instructions to create the environment are contained in the SAP Quotation and Underwriting for Insurance
Installation Guide.

8

® Note

Record the JDBC information including the JDBC URL and development database user credentials to
configure the FS-QUO toolkit database connection.

PUBLIC
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3.2 Installing and Configuring Eclipse

This topic details the steps required to install and configure Eclipse for use with the FS-QUO toolkit.

Context

Perform the following steps to install Eclipse:

Procedure

1. Unzip eclipse-jee-oxygen-3a-win32-x86_64.zip to alocal directory, which will be referred to as
<eclipse_dir>inthis guide.

2. Editeclipse.ini to configure Eclipse to use the JDK as the default VM.

a. Open<eclipse_dir>\eclipse.ini with atext editor.
b. Add the following lines to the beginning of the file:

-vm
<jdk_dir>\bin\javaw.exe

c. Save your changes and close the file in the editor.
3. In Windows Explorer, open Eclipse by browsing to <eclipse_dir>and running eclipse.exe.

4. When prompted to select a workspace, either use the default path or provide a temporary path to open
Eclipse.

5. If you are working behind a network proxy, configure Eclipse with the proxy server information as follows:
a. Select | Window » Preferences 3 in the top menu bar.

b. Expand the left menu tree to | General » Network Connections 3.

c. Select the Manual proxy configuration option in the configuration pane and enter the HTTP proxy and
SSL proxy details.
If you don't have this information, contact your system or network administrator.

d. Choose OK.
Your changes are saved.

6. Install any other Eclipse features, such as for source control, as appropriate for your development
environment.

Development Toolkit Guide
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3.3 Installing and Configuring TomEE+

The FS-QUO toolkit uses Apache TomEE+ 1.7.5 as the local application server, which must be installed and
configured.

Context

The SAP Java Buildpack, bundled in SAP HANA XS Advanced, provides TomEE as one of the Java runtime
environments which FS-QUO uses. For local development, FS-QUO toolkit uses a stand-alone installation of
TomEE+. While on SAP HANA XS Advanced the TomEE installation is configured as the FS-QUO application
is deployed, the local TomEE installation for the FS-QUO toolkit must be manually configured to adopt to
FS-QUOQO's requirements.

Procedure

1. Unzip apache-tomee-1.7.5-plus.zip to alocal directory, which will be referred to as <tomee_dir>
throughout this document.

2. Make a backup copy of the following files in <tomee_di r>\conf, both of which will be customized for
FS-QUO later:

* system.properties
* tomee.xml
3. Customize <tomee_dir>\conf\system.properties as follows:

a. Open<tomee_dir>\conf\system.properties in atext editor.
b. Add the # character in front of the following line in the file to comment it out:

tomee.serialization.class.blacklist = *

c. Add the following lines to the bottom of the file:

openejb.classloader.forced-load=org.apache.commons
org.apache.activemq.SERIALIZABLE PACKAGES=*

d. Save your changes and close the file in the text editor.

Results

TomEE+ is now installed and configured for integration with Eclipse for use by the FS-QUO toolkit.

Development Toolkit Guide
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3.4 Installing and Configuring the FS-QUO Toolkit

After the initial Eclipse and TomEE application server setup is complete, you can set up the FS-QUO toolkit as
an Eclipse workspace by following the instructions in this section.

3.4.1 Unzipping the FS-QUO Toolkit

The FS-QUO toolkit is provided in the form of an Eclipse workspace directory.

Unzip FS-QUO-toolkit-<rel>._.<sp>.<pl>-backend.zip to alocal directory, referred to as
<toolkit _dir>.

® Note

Don't use a directory containing spaces in its path.

3.4.2 Setting up a Development Profile

Context

To provide a consistent development environment to all developers, the FS-QUO toolkit introduces a concept
called development profile. A development profile contains artifacts that are common across the development
project, including the following items:

* JDBC driver and data source XML file

* TomEE data source XML file

* FS-QUO configuration files in <CS1_HOME>
* Insurance product JAR files in <CSI1_HOME>

Perform the following steps to set up a development profile:

Procedure

1. Create the new directories <toolkit_dir>\FS-QUO-toolkit\FS-QUO-dev\src\profiles and
<toolkit_dir>\FS-QUO-toolkit\FS-QUO-dev\src\profiles\<dev_profile_name>.

2. Create the following subdirectories under the newly created development profile:

* home

Development Toolkit Guide
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* server\conf
* server\lib
Copy the SAP HANA JDBC driver file (ngdbc. jar) that you

downloaded as a prerequisite to <toolkit_dir>\FS-QUO-toolKit\FS-QUO-
dev\src\profiles\<dev_profile_name>\server\lib.

Copy the sample TomEE configuration file in <toolkit_dir>\FS-QUO-
toolkit\FS-QUO-dev\src\samples\tomee.xml to <toolkit_dir>\FS-QUO-toolkit\FS-QUO-
dev\src\profiles\<dev_profile_name>\server\conf.

Openthe new <toolkit_dir>\FS-QUO-toolkit\FS-QUO-
dev\src\profiles\<dev_profile_name>\server\conf\tomee.xml file with a text editor.

Replace the placeholder texts surrounded by ### signs with information specific to the FS-QUO Runtime
database that you created earlier in the XML file.

Save your changes.

8. Close the file in the text editor.

3.4.3 Initializing the FS-QUO Toolkit Workspace in Eclipse

Prerequisites

You have JDK 1.8 installed
You have Apache Maven version 3.2.2 installed.

Context

Now the workspace is configured in the file system, perform the following steps to initialize the workspace
within Eclipse by importing projects and creating a TomEE server:

Procedure

12

Create a parent directory for the <toolkit_dir> directory, which will be your Eclipse workspace location.

Open Eclipse and provide the parent directory created in the previous step as the workspace location when
prompted.

Verify the JRE and compiler settings:
a. Choose |» Window ¥ Preferences : from the menu bar.

b. Select|» Java ¥ Installed JREs » Execution Environments » JavaSE-1.8 : and check the 1.8 JDK that
was previously added.

Development Toolkit Guide
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c. Select|r Java » Compiler ¥ JDK Compliance Jfrom the menu tree and set your compiler level by
selecting 1.8 from the dropdown.

o

Select | Maven ¥ Installations 3 in the menu tree.
Ensure the apache-maven-3.2.2 installation is selected.

o®

Select | Maven » Java EE Integration Jin the menu tree.
Under Select active Java EE configurators, deselect all three configurator options.

h. Choose OK.
Your changes are saved.

0

4. Select|p Window ¥ Open Perspective ¥ Other... 3 from the menu bar, then select Java EE to open the Java
EE perspective.

5. Import the projects into the workspace as follows:

a. Inthe menu bar, select |} File » Import... 3, then select |+ Maven » Existing Maven Projects into

Workspace... 3 and choose Next.

b. Choose Browse... for the Select root directory field and select <toolkit_dir> (which should be
selected by default).

c. Choose OK.

d. Ensure that Select All has been chosen by default and choose Finish.

® Note

Immediately after import, the workspace will contain numerous build path errors. The next few steps
will provision Maven dependencies properly and resolve these errors.

There are also errors in the following categories that will persist but can be ignored:
* WSDL Problem
* XML Schema Problem
* XSL Problem

6. Inthe Project Explorer view, select FS-QUO-toolkit and choose |[# Maven » Update Project... 3 from the
popup menu. In the new dialog, choose OK, then wait for the workspace to be updated and built.

7. Inthe Project Explorer view, select FS-QUO-toolkit and choose |# Run As... » Maven install 3 from the
popup menu.
Maven will install binary artifacts from the FS-QUO toolkit to your local Maven repository as part of the
initialize phase, compiling, running unit tests, and installing artifacts on all projects.

When the update has completed, ensure that there are no Java problems in the Markers view. To remove
Java problems 'related to build path errors' after a successful Maven installation, run the Maven Update
project again and it should remove those errors.

8. Initialize the <CS1_HOME> directory and the development profile as follows:

a. Inthe Project Explorer view, select FS-QUO-dev and choose [ Run As... ¥ Maven build... J from the
popuUp Menu.

b. Enter conpi | e in the Goals field.

c. Add the following parameters:

tomee.dir: <tomee dir>
profile: <dev_profile_name>

Development Toolkit Guide
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d.

Choose Run to run the Maven configuration.

9. Perform the following steps to generate an encryption key required by FS-QUO:

a.
b.

Ensure system variable JAVA_HOME is set in your system properties to point to a Java directory.

Open the following file with a text editor and change the properties according
to the file comments to set a passphrase: <toolkit_dir>\FS-QUO-toolkit\FS-QUO-
dev\target\home\bin\genkey.properties

The key will be generated by converting characters to a series of numbers in 0-255 range.

The passphrase can be of any length and contain any characters (including Unicode). The
recommended size is at least 16 characters for a 128-bit key.

Run the <toolkit_dir>\FS-QUO-toolkit\FS-QUO-dev\target\home\bin\genkey.bat
command and follow the displayed instructions to generate a key.

The key.configfile is generated in <toolkit_dir>\FS_QUO-toolkit\FS-QUO-
dev\target\home\system\config.

10. In the Project Explorer view, select FS-QUO-toolkit and choose | Maven » Update Project... 3 from the
popup menu. In the new dialog, choose OK, then wait for the workspace to be updated and built. At this
point, all Java build path problems should be resolved.

11. If you don't already have a server defined, create one in the Servers view:

Right-click on the Servers view area and choose [ New » Server J from the popup menu.

b. Onthe Define a New Server wizard page, select Tomcat v7.0 Server in the Apache folder as the server

d.

type and choose Next.

This server type is compatible with TomEE 1.7.

® Note

To better identify the server type, you can change the default name Tomcat v7.0 Server at localhost
to TomEE+ v1.7.5 Server at localhost or a similar name for the server.

On the Tomcat Server wizard page, enter the <tomee_dir> in the Tomcat installation directory field
and then choose Next.
In the Add and Remove wizard page, choose Finish.

12. Configure the server JVM system properties for FS-QUO as follows:

In the Servers view, open the server in the server editor.

Expand Server Locations and select Use Tomcat installation (takes control of Tomcat installation).
Expand Timeout and increase the value of Start (in seconds) to 90, and Stop (in seconds) to 30
respectively.

Finally, in the top menu bar, select [ File » Save 1 to save the settings.

e. While still in the Overview tab, choose the Open launch configuration link in the General Information

14

section.
In the VM arguments field, ensure the following arguments are present:

-DCSI .home=<toolkit_dir>/FS-QUO-toolkit/FS-QUO-dev/target/home
-Dfile.encoding=UTF-8

-Dorg.eclipse.emf.ecore.EPackage.Registry. INSTANCE=org.eclipse.emf.ecore.im
pl.EPackageRegistrylmpl

Ensure that you use '/' as the file separator for the CS1 .home value.

Development Toolkit Guide
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13. Choose OK.
Your changes are saved.

14. Close the server editor.
15. Add the EAR module to the TomEE server for deployment.

a.

Right-click TomEE+ v1.7.5 Server at localhost in the Servers view and choose Add and Remove... from
the popup menu.

Select FS-QUO-dev-webapp(FS-QUO-dev-webapp-<rel>.<sp>.<pl>) from the Available list and
choose Add.

. Choose Finish.

Your changes are saved.
Go to the Modules tab, select Edit... and change the Path to /csiroot.

e. Select OK to save your change.

Right-click TomEE+ v1.7.5 Server at localhost in the Servers view and choose Publish from the popup
menu.

To verify, open <tomee_home>\apache-tomee-plus-1.7_.5\conf\server.xml in the editor and
go to the end. Ensure that the path has been changed to Zcsiroot. If the change is not present, you
may need to restart TomEE multiple times.

3.4.4 Validating the Initial Configuration of the FS-QUO

Toolkit

Context

With the initial configuration completed, start the server and verify that the FS-QUO application is running:

Procedure

1.

In the Servers view, select TomEE+ v1.7.5 Server at localhost and choose Start from the popup menu.

Note the port number that will be used to connect to the Administrative Console. The default port for
TomEE is 8080.

. Wait for the server to start.

When the start process is completed, check the Administrative Console view to ensure that the application
starts without errors.

Launch Internet Explorer and and log in to the Runtime Administrative Console at the following location:
<quo_toolkit_url>/csiroot/admin/.

Log in using adm n as the user name and passwor d as the password.

The application has started successfully if you can access the Runtime Administrative Console.

Development Toolkit Guide
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5. Choose Logout.

3.4.5 Configuring the Runtime Administrative Console

Context

Procedure

1. Launch Internet Explorer and log in to the Runtime Administrative Console.

2. Configure the ICM application ID in FS-PM:

a0 o o

Go to | System » Edit Configuration Settings 3.

Go to [ Configuration » Application ¥ AuthoritySuite » Env » FS-PM Integration Setting 3.

Enter value for icm.application. idinthe Override field

Save your changes.

Goto |+ System » Reload Configuration Settings 3

A list of options appears in the tree panel.

Select the configuration setting type that you want to reload, or choose Reload All Config to reload all
the settings.

3. Ifyour solution includes an integration with a Content Management System (CMS) you will need to
configure the following settings:

a.

b.
c.

Go to | System » Edit Configuration Settings 3.

Go to |» Configuration ¥ System ¥ Env #» Content Management System Setting 4.
Enter values in the Override columns for CMSServerUrRL, CMSServerUser and
CMSServerPassword.

. Save your changes.

Go to |+ System » Reload Configuration Settings 3

A list of options appears in the tree panel.

Select the configuration setting type that you want to reload, or choose Reload All Config to reload all
the settings.

4. Configure the Virus Scan Interface (VSI) setting:

16

Go to | System » Edit Configuration Settings 3.

Goto | System » Env ¥ Virus Scan Interface Setting 3.

Entercom sap. fs. uw. cns. servi ce. i npl . Vi rusScanSer vi ceFor Mock in the Override field for
VirusScanService.

Save your changes.

Go to |+ System » Reload Configuration Settings 3

Development Toolkit Guide
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A list of options appears in the tree panel.

f. Select the configuration setting type that you want to reload, or choose Reload All Config to reload all
the settings.

3.5 Configuring the Toolkit for Content Management
Systems (CMS)

To enable evidence uploads in your development environment, you need to configure settings for your CMS.
->Tip

When doing custom FS-QUO development and connecting to a new CMS Server, a certificate change may
be needed on the machine hosting the runtime application.

Changing the binding type and other session parameters

The default implementation is using "BROWSER" binding type when connecting to the CMS Server. When
connecting to a different CMS, that value may have to be changed. Other common values are ATOMPUB and
WEBSERVICES. The value can be changed through the override of the following class and method:

Class: SmdRepositoryConnector

Method: getSessionParams

Code to override:
sessionParams.put(SessionParameter.USE
R, userName);
sessionParams.put(SessionParameter.PAS
SWORD, password);
sessionParams.put(SessionParameter.BRO
WSER_URL, serverUrl);
sessionParams.put(SessionParameter.BI N
DI NG TYPE,
BindingType.BRONSER.value());
sessionParams.put(SessionParameter.COO
KIES, "true");
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Getting the right repository on the CMS Server

The default implementation uses the "My Documents" repository of the CMS Server. The value is set in the
code, and can be changed through the override of the following class and method:

Class: SmdRepositoryConnector

Method: createSession

Code to override:
Repository repository =
repositories.get(i);
if(repository.getName().trim() .equals(
"My Documents'™))

Changing the upload folder within repository

The default implementation is using the "/<CMSServerUser> folder within the repository for file upload. This
means all the uploads are stored in the folder with the same name as the CMS user account. This logic can be
customized through the overrides of the following code:

Class: SAPMobi leDocumentsService

Method: uploadContent

Code to override:
String mobileDocUserName =
SystemConfig.getinstance() -getPropert
y(*'CVsSer ver User ') ;
String fullFolderPath = "/ +
mobileDocUserName + folderPath;

Guide to main implementation classes of evidence upload and download

SAPMobileDocumentsService Orchestrates connection to CMS Server and file up-
load/download

CMSUploadProcessor Invokes upload logic through CMSServiceFactory
CMSDownloadProcessor Invokes download logic through CMSServiceFactory
SmdRepositoryConnector Manages session with the CMS Server.
CMSServiceFactory Creates an instance of CMSService through reflection.
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3.6 Configuring the FS-QUO Toolkit for FS-QUO

Context

At this point, the FS-QUO development environment is only set up as the Runtime engine, but it doesn't yet
have the complete setup necessary for underwriting. You still need to update the configuration settings.

If your product requires FS-PM and SAP GP-FS integration, refer to the Integration Guide for Coverage-based
Insurance Solutions for instructions to configure integration settings in the FS-QUO Administrative Console.

3.6.1 Updating Configuration Settings

The configuration settings need to be updated as part of the FS-QUO installation process.

Context

To update the configuration settings, perform the following steps:

Procedure

1. Launch Internet Explorer and log in to the Runtime Administrative Console at the following location:
<quo-toolkit-url>/csiroot/admin/.
The Runtime Administrative Console will open after a short delay.

2. When prompted, log in as <admin_user>.
3. Choose||¢ System # Edit Configuration Settings 3 from the menu bar.
4. Goto|p Configuration j» Application » AuthoritySuite » Env » Application Environment 3 .

The Application Environment settings display.

a. Inthe Override field for the FSPMBookingServiceEnabled row, enter YES.
b. Save your changes.

5. Goto|p Configuration » System » Env » Content Setting 1.

The Content Setting settings display.

a. Confirm that your Application Data Model Product is present in the Override field for the
ApplicationDataModelProduct row. If it is not present, enter it.
b. Save your changes.
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6. Choose | System » Reload Configuration Settings 3 from the menu bar,
7. Choose Reload All Config.

3.7 Copying and Deploying Insurance Product JAR Files
from the Product Modeler

The FS-QUO toolkit requires insurance products to be deployed to provide meaningful contents in runtime. You
will need to deploy the products to the FS-QUO toolkit.

Prerequisites

Your organization should already have a Product Modeler instance set up and insurance products imported or
developed.

Procedure

1. Launch Internet Explorer and log in to the Product Modeler at the following URL: https://
<pro_designtime_app_url>/csiroot/ii/pc/
The Product Modeler will open after a short delay.

2. Ensure that the products selected for deployment have been published.

3. Download the product JAR files from the above location to the system where the FS-QUO toolkit is set up.

a. Open the product Sﬂ )

b. Go toll File » Download Product (JAR) 3.
A dialog appears.

¢. Choose Download.
A system dialog appears.

d. Choose Save and specify where you want to store the JAR file.
e. Select Logout at the upper-right of the page.

4. Open Eclipse using the FS-QUO toolkit workspace, and ensure that the server is started.
5. Launch Internet Explorer and log in to the Runtime Administrative Console at the following location:
<quo_toolkit_url>/csiroot/admin/

The Runtime Administrative Console will open after a short delay.

6. Select | Product » Deploy Products 3 from the menu bar.
For each insurance product JAR file to be deployed, perform the following actions:

a. Browse to the location of the JAR file.
b. Select the file.
c. Choose Upload.
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8. Verify that the product JAR files are deployed and registered successfully by validating that the
same set of insurance product JAR files now exist in <toolkit_dir>\FS-QUO-toolkit\FS-QUO-
dev\target\home\ps\product.

3.8 Installing and Configuring Standalone SAP JCo
(Optional)

® Note
SAP JCo is only releveant for FS-PM and SAP GP-FS integrations.

SAP JCo (both version 2 and 3) is required by FS-QUO to make RFC and APIF calls to FS-PM and SAP GP-FS
in an integrated landscape. For an insurance product requiring integration, such as the Sample Household
Product, you must install SAP JCo and make it available to the standalone server to write new business.

- Tip

For SAP JCo 2.x, go to the Support Packages & Patches section of the SAP Download Center. Then go to
Archive by Alphabetical Index (A-Z) and select J. Next, choose SAP JCO and then select SAP JCO 2.1.

After you have downloaded the software, install it by unzipping the file to a local directory and copying the
sapjco. jar (version 2), sapjco3. jar, and sapjco3.dl 1 files to the <tomee_dir>\lib directory. Then
restart the TomEE Server from Eclipse.

Related Information

Prerequisites for Installing the FS-QUO Toolkit [page 4]

3.8.1 Configuring JCo Standalone Settings in FS-QUO

In a standalone development enviroment, you will need to define standalone JCo settings to connect to
integrated SAP systems.

Prerequisites
Confirm the destination names for FS-PM and SAP GP-FS RFC connectivity that's defined in the RFC reference

object in FS-PRO.

They will be referred to as <FS-PM_dest_name> and <BP_dest_name> respectively in the following steps.
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For more information, see Configuring RFC Destinations in Products.

Procedure

1. Create a properties file for the FS-PM connection.

a. Open atext editor.

b. Add the following text to the file and add the appropriate JCo client settings in the file with connection
details for the FS-PM system:

jco.
jco.
jco.
jco.
jco.

where:

client

user

sysnr

ashost

lang

client.client=
client.user=
client_sysnr=
client.ashost=
client. lang=

Specifies the SAP client number.

Three-digit client number; preserve leading zeros if they appear in the number.

Specifies the login user ID.
User name for logging in to the SAP system.
Ensure that the User ID entered here has all of the required permissions in FS-PM.

This is a technical user account. SSO/Principal Propagation is not supported.

Indicates the SAP system number.

Identifies the SAP application server.

Host name of a specific SAP application server.

Specifies a login language.

Use the SAP-specific single-character language code.

c. Save the file as FSPM_DEST . jcoDestination to a local directory.

2. Create a properties file for the FS-PM connection.

22

a. Open a text editor.

b. Add the following text to the file and add the appropriate JCo client settings in the file with connection
details for the SAP GP-FS system:

jco.
jco.
jco.
jco.
jco.

PUBLIC

client.client=
client.user=
client.sysnr=
client.ashost=
client._lang=
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where:

client
Specifies the SAP client number.
Three-digit client number; preserve leading zeros if they appear in the number.
user
Specifies the login user ID.
User name for logging in to the SAP system.
Ensure that the User ID entered here has all of the required permissions in FS-PM.
This is a technical user account. SSO/Principal Propagation is not supported.
sysnr
Indicates the SAP system number.
ashost
Identifies the SAP application server.
Host name of a specific SAP application server.
lang

Specifies a login language.
Use the SAP-specific single-character language code.
c. Save the file as BP_DEST. jcoDestination to alocal directory.
3. Launch Internet Explorer and go to <quo_runtime_app_url>/csiroot/admin/.

4. Log in to the Runtime Administrative Console as <admin_user>.
The Runtime Administrative Console will open after a short delay.

5. Upload the files to the file system.
a. Goto|k System » Edit File System .

A list of folders appears in the tree, and the folders and files in the selected folder appear in the details
panel.

b. From the Path dropdown list, select PA - Custom Web Root (Write).

c. Expand the resource folder in the tree and go to the rfcdestination folder.

d. Right-click the rfcdestination folder, and choose Upload.

The Upload Files dialog appears.
e. Upload both of the destination properties files.

You can upload a maximum of eight files at one time.

® Note

If you have the following entries already configured within [ Configuration » System » Env » RFC
Standalone Credential Setting 3 then you don't need to proceed with steps 8 and 9 unless you are
altering the existing names:

* FSPM DEST_STANDALONE PWD

* BP_DEST_STANDALONE_PVD
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6. Choose | System » Edit Configuration Settings 3 from the menu bar.

7. Select | Configuration » System 7 from the configuration tree.

8. Add a new configuration variable for your FS-PM connection password entry.

a.

Sm e a0 o

In the editor pane, select RFC Standalone Credential Setting from the Configuration dropdown list.
Choose the Add Config Variable button.

Enter FSPM_DEST_STANDALONE_PWD in the Name field.

Enter the password for <FS-PM_dest_name> in the Description field.

Ensure that the Mandatory checkbox is deselected.

Enter Encrypt Text inthe Control field.

Ensure that the Enumeration field is blank.

Ensure that the Default field is blank.

Save your changes.

9. Add a new configuration variable for your SAP GP-FS connection password entry.

Sm e a0 o

In the editor pane, select RFC Standalone Credential Setting from the Configuration dropdown list.
Choose the Add Config Variable button.

Enter BP_DEST_STANDALONE_PWDin the Name field.

Enter the password for <BP_dest_name> in the Description field.

Ensure that the Mandatory checkbox is deselected.

Enter Encrypt Text inthe Control field.

Ensure that the Enumeration field is blank.

Ensure that the Default field is blank.

Save your changes.

10. Go to | Configration  System » Env Jin the configuration tree and select RFC Standalone Credential.

11. Enter the password of the user for the RFC connection to the FS-PM system in the Override field of the
FSPM_DEST_STANDALONE_PWD property and choose Save.

12. Enter the password of the user for the RFC connection to the SAP GP-FS system in the Override field of the
BP_DEST_STANDALONE_PWD property and choose Save.

13. Select | System » Reload Configuration Setting 3 from the menu bar and choose Reload All Config for the
new password settings to take effect.

3.8.2 Testing RFC Destinations

You need to verify that the connectivity defined in the destinations is functional.

Procedure

1. Login to the Administrative Console.

The Administrative Console will open after a short delay.

2. Select | System ¥ Test SAP Server Connectivity 3.
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3. Gotothe Test JCo3 Feature tab, select the destination and choose Connect to test the connection.

4. Repeat these steps for all destinations.

Results

A pop up message indicates whether the connection is valid or invalid.

3.9 Creating a User and Assighing Authorization

You will require a user for your local development environment and assign it the necessary authorizations to
access the platform and the apps.

® Note

Developers who are customizing Fiori apps should have taken an Open SAP course on Fiori application
developments, or are working closely with developers who have experience with Fiori application
development experience.

You will need to create a user in the Administrative Console Role Painter specifically for FS-QUO. This user
is required to authenticate the session established between the Cloud Platform account and the on-premise
FS-QUO application server.

Ensure that the user has been assigned the following roles in Role Painter:
* QUO_UW_HO_LOB_PNC
* SAP_UW_HOUSEHOLD
° SAP _UW_LIFE
* UWFullAccess
* UWSUBMISSION_DATA_ENTRY
* UW_User_ RC
* assignSubmission
* uwCaseMassReassign
* uwSimulate

* uwSubmissionListQuery

For more information about Role Painter, see Product Web Services User and Authorization Management.
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3.10 Setting up a Personal Development Subaccount on SAP
Cloud Platform Neo

You need to create a personal development subaccount on SCP Neo, which will be used for Fiori application
development.

1. Ensure that a Global account is created on SCP Neo.
2. Create an individual subaccount for each developer.
3. Foreach subaccount, follow the instructions on the Getting Started topic.

3.11 Setting Up Connectivity to the FS-QUO Front-End

In order to view the apps in a development environment, you will need to establish a connection to the FS-QUO
front-end.

Prerequisites

You must have an SAP Cloud Platform account (either a customer account or a trial account).
You have already enabled SAP Web IDE Full-Stack in your account.

A user must have already been created in Role Painter specifically for FS-QUO. This user is required to
authenticate the session established between the Cloud Platform account and the on-premise FS-QUO
application server

Context

Procedure

1. Install the SAP Cloud Connector on the local development system.
2. Set up the Cloud Connector to connect to the SAP Cloud Platform subaccount.

a. Start the Cloud Connector.

For more information, see SAP Note 2485510 #
b. Complete the initial configuration of Cloud Connector.

For more information, see Initial Configuration.
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f.

® Note

Ensure that you enter the full address of the Region instead of using the provided dropdown values.
For example, enteri nt . sap. eu2. hana. ondenmand. cominstead of choosing Europe(Frankfurt).

Select Cloud To On-Premise menu item for the sub-account.

. Select the ACCESS CONTROL tab.

Add a new virtual host to the internal system mapping. This mapping will allow the exposure of the
on-premise system (FS-QUO application server) to the SAP Cloud Platform subaccount. Configure it
via the following properties:

Back-end Type: Select Non-SAP System from the dropdown list.
Protocol: Select HTTP from the dropdown list.

Internal Host: Enter the name of the internal host name (the host name for the on-premise
system). For example, localhost or the designated IP of the server machine.

Virtual Host: Assign a name for the virtual host in the text field.

Internal Port: Enter the internal host port number (the port number of FS-QUO application server
instance).

Virtual Port: Assign a name for the virtual port in the text field.
Principal Type: Select None from the dropdown.
Host In Request Header: Use the Virtual Host value.

Click Check Result in the actions menu and ensure that the result is Reachable.

Add the new accessible resource for system mapping.

URL Path: Enter the base URL path for FS-QUO (/csiroot).

Active: Ensure that this checkbox is selected.

Access Policy: Select the Path and all sub-paths radio button.

g. Verify in the Cloud Connectors section of the SAP Cloud Platform Cockpit that the Cloud Connector is
connected and that the back-end system is exposed.

3. Create and set up an SCP destination in the SAP Cloud Platform Cockpit called FS_QUO with the following

configuration:

a.
b.

> @ -

Select HTTP from the Type dropdown.
Enter <ur | >/ csi r oot inthe URL field.

The value for <url>is the URL of the virtual host

Select OnPr eni se from the Proxy Type dropdown.

. Select Basi cAut hent i cat i on from the Authentication dropdown.

Enter the user name and password of the FS-QUO user from Role Painter.

Go to the Additional Properties tab.

Enter TRUE in the WebIDEEnabled value field.
Set the WebIDESystem value to API .

Set the WebIDEUsage value to odat a_gen.

Save your changes.

Confirm that the connections works by selecting Check Connection .
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Related Information

Prerequisites for Installing the FS-QUO Toolkit [page 4]

3.11.1 Importing and Deploying Apps to the Fiori Launchpad

You will need to setup the FS-IPW apps in the Fiori Launchpad sandbox.

Procedure

1. Copy FS-QUO-toolkit-<rel>_<sp>._.<pl>-frontend.zip to your local machine and extract it.
2. GototheWeb IDE Full-Stack service for your Neo Subaccount and ensure that the service is enabled.
3. Select Go To service in the Overview tab to open SAP Web IDE link.
4. Select Default Workspace on the left panel.

5. Import all of the apps, one by one, into a default workspace by performing the following steps:

Go to | File » Import ¥ File or Project 1.

Browse the app ZIP file extracted from the main FS-QUO toolkit front-end ZIP file.
Click Import.

a0 oo

Expand the imported app, open package . json and add the following line in devDependencies
"vscode-uri': "1.0.6" (Ref: SAP Note 2801814 #%)

e. Savethefile.

6. Right click on the project that you want to deploy to the Fiori Launchpad and select |» Deploy ¥ Deploy to
SAP Cloud Platform j Deploy a new application .

If you receive the following error message The account must have a subscription to SAP Fiori
Launchpad®, you need to enable Portal service under User Experience in Services tab to subscribe to FLP.

7. After the new applications get deployed, select register to SAP FLP in the new popup. The application
configuration should be the same as the table below:

App Name Semantic Object Action Title Icon Type
fs.ipw.insquote.create InsuranceQuote create Create Insurance Quote create Static
fs.ipw.inspolicy.manage InsurancePolicyFor- manage Manage Issued Policies request Static
Quote
fs.ipw.myinsworklist InsuranceQuote manage My Insurance Worklist task Static
fs.ipw.myuwworklist UnderwritingCase manage My Underwriting Worklist  task Static
fs.ipw.grpinsquote.create GrouplnsuranceQuote  create Create Group Insurance create Static
Quote
fs.ipw.myinstasks InsuranceTask manage My Insurance Tasks task Static
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App Name Semantic Object Action Title Icon Type

fs.ipw.mstrinsquote.create  MasterIinsuranceQuote create Create Insurance Quote create Static
From Master

fs.ipw.mstrinspolicy.create  MasterinsurancePolicy  create Create Master Insurance create Static
Quote

® Note

The Semantic Object and Action values are case-sensitive.

All apps must be registered to the same Fiori Launchpad site that you defined for your local environment.

Next Steps

If you get 401 authorizationor fail to load SAPUI5 Component errors while accessing the app,
perform the following steps:

Open the Runtime Administrative Console

Go to | User » Edit Users 3.

Search for the user that you created in Creating a User and Assigning Authorization [page 25].
Select the user and then choose the Reset user's password link on the right side.

Perform a hard reset to the Fiori Launchpad to load all of the apps.

Try to access the apps again.

R N

3.11.2 Setting Up App-to-App Navigation

The Create Insurance Quote from Master app requires separate configuration to be applied for app-to-
app navigation.

Prerequisites

Ensure that you have already set up connectivity to the FS-QUO front end.

Context
You only need to perform this procedure if you are developing coverage-based apps.
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Procedure

1. Inthe WeblIDE Files view, right-click on one of the apps and select |+ Project » Enable App to App
Navigation .

The App 2 App Navigation pop-up dialog opens.

Select all listed apps in the Navigate to field and select Enable.

Once FLPSandbox appears in the workspace, expand the folder in the Files view and open neo-app - json.
Scroll to the bottom and remove all but one of the destination definitions for FS_QUO.

Change the path value to/ csi r oot / and then remove the entryPath entry.

Save the file and close it.

Select FLPSandbox in the Files view.

Select | Run » Run Configurations... 3 from the menu bar.

© 0 N DO AW

Select App 2 App Navigation from the menu on the left.

—
(@]

. Inthe main tab, select the Advanced Settings tab. Under Application Destinations, select the appropriate
destination name for the local FS-QUO system and select Save and Run.

3.12 Copying the <CSI1_ HOME> Artifacts to the Development
Profile

After the local FS-QUO toolkit set up is complete, you should update the development

profile with the artifacts from the <CSI1_HOME> directory. Copy the following directories

from <toolkit_dir>\FS-QUO-toolkit\FS-QUO-dev\target\home to <toolkit_dir>\FS-QUO-
toolkit\FS-QUO-dev\src\profiles\<dev_profile_name>\home:

* ppms\app\runtime
* ps\product

The FS-QUO toolkit is now completely set up for the first time. For team development, you should check
<toolkit_dir>into your source control system so it can be accessed by your development team. As you
have already done most of the setup, each subsequent developer would only need to perform the following
steps to set up their own FS-QUO development environment:

1. Installing and configuring Eclipse.

2. Installing and configuring TomEE+.

3. Installing and configuring the FS-QUO toolkit.
For Unzipping the FS-QUO toolkit, replace the instruction with checking out the toolkit directory from
source control.

After that, the development team can verify the integrated SCM tools within Eclipse and link each project to
your source control system for updates and commits.
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3.13 Building the Custom FS-QUO MTA on the XSA server

Extensions and customizations made in the FS-QUO toolkit must be built and packaged so that

they can be deployed to an FS-QUO runtime environment. The following custom artifact needs to

be generated for deployment: <toolkit_dir>\FS-QUO-toolkit\FS-QUO-mta\target\FS-QUO-mta-
<rel>_<sp>.<pl>_.mtar

However, instead of generating artifacts for deployment manually from the FS-QUO-toolkit, you should
implement a build process that does the following:

1. Check out the FS-QUO toolkit source code from your source control system.

2. Run Maven install on the FS-QUO-toolkit Maven reactor module to generate the build artifacts.

3. Archive the build artifacts to a central location, such as a Nexus repository or in the Jenkins project, for
deployment.
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4 Changing Default Error Report Settings

The error report on the Exception screen contains a summarized description of the errors. If you want to view
more details, you must override the default flag in local environments by changing the flag from Yes to No.

You can find the flag, SuppressErrorinAS in the following location in the Administrative Console:

Application » Product Authority » Env » Application Environment
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Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

®  Links with the icon o : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your
agreements with SAP) to this:
®  The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
®  SAPdoes not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any
damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.
L]

Links with the icon ’h": You are leaving the documentation for that particular SAP product or service and are entering an SAP-hosted Web site. By using
such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this
information.

Videos Hosted on External Platforms

Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within
the control or responsibility of SAP.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by
SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use
the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your
feedback (e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax
and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of
example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Bias-Free Language

SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities,
genders, and abilities.
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